
File menu commands

The File menu offers the following commands:

New Creates a new Sounds and Noises document.
Open Opens an existing document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.A 

name is    proposed using the sounds you may have 
added to the document..

Exit Exits Sounds and Noises.



Edit menu commands

The Edit menu offers the following commands:

Enable Editing This must be set, to enable editing of 
sounds in the scene.

Delete Sound Deletes data from the document and 
moves it to the clipboard.

Undo Last Replaces the last sound that you 
deleted, using    Delete Sound.

Clear All Clears all sounds currently in the 
document.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.    
Status Bar Shows or hides the status bar.    
Full Screen - Hit ESC to 
Cancel!

Shows only the scene, not the 
Window frame work.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Quick Start Quickly shows you how to add 
sounds and build sentences

Index Offers you an index to topics on 
which you can get help.

Using Help Provides general instructions on 
using help.    

Context Sensitive Help A great way to find out about 
something you can click on.

Show Welcome at Start This will cause the Welcome 
Introduction to be displayed when
you next start Sounds and Noises

Playing Demo Runs a demonstration of how to 
use Sounds and Noises

Editing Demo Runs a demonstration of how to 
create new sound combinations

About Displays the version number of 
this application.

New command (File menu)
Use this command to create a new document in Sounds and Noises. 
You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing Sounds and Noises document.    
You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    Sounds and Noises documents end in .phm by 
default.

List Files of Type
Select the type of file you want to open:
Normally, you should not need to change this, if you are happy using .phm as the filename extension 
for your Sounds and Noises documents.

Drives
Select the drive in which Sounds and Noises stores the file that you want to open. 

Directories
Select the directory in which Sounds and Noises stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.    If you do not 
have a network attached to your computer, this button will do nothing. 



Save command (File menu)
Use this command to save your current Sound And Noises session as a document to its current name 
and directory.    When you save a document for the first time, Sounds and Noises displays the Save As 
dialog box so you can name your document.    If you want to change the name and directory of an 
existing document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save your current Sound And Noises session as a document.    Sounds and 
Noises displays the Save As dialog box so you can name your document.    A name is    proposed using 
the sounds you may have added to the document. If you do not like the choice of filename, or it is 
identical to another name displayed in the file list, type in a new name, upto 8 characters long.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Sounds and Noises adds the extension .phm 
if you only enter upto eight characters, without the extension.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)
This is a great way to open one of the four most recently used Sounds and Noises documents. Just click
on the title of the desired document, or using the keyboard type the number that corresponds with the 
document you want to open.



Exit command (File menu)

Use this command to end your Sounds and Noises session.    You can also use the Close command on 
the application Control menu.    Sounds and Noises prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Enable Editing command (Edit menu)
When this menu item is checked, or its corresponding tool bar button is set pressed in, then background 
animation is temporarily halted, and the other items on the Edit menu are enabled (no longer grey).    As 
well as permitting deletion of sounds, this command enables you to click on a sound and drag it with the 
mouse to a new location in the scene.    If the sound has been    connected (Connect Sounds) with a 
neighbor, then when the sound is dragged, its neighbors originally to the right of it will be moved also.    If 
the menu item Disconnect Sounds is clicked, the invisible link between sounds is removed, and each 
sound can be moved independently with the mouse.    Once the correct layout has been achieved, place 
those sounds you intend to sound out in sequence, next to each other, in the same sequence.    Then 
select Connect Sounds to reestablish the invisible links between only the adjacent sounds.

For a more general discussion of editing, see Editing the Sounds as part of the Quick Start    tutorial.



Delete Sound command (Edit menu)
Deletes the mosth recently clicked-on sound.    If you are not sure which one you last clicked, then click 
the one you want to delete once more.    If you delete the wrong one by accident then choose Undo Last.



Undo Last command (Edit menu)

Replaces the last sound that you deleted, using Delete Sound .    Once you undone the deletion, this 
item will be disabled on the menu, until another deletion has taken place.



Clear All command (Edit menu)

This command deletes all the current sounds that are in the document, while keeping the same filename
for the document.



Toolbar command (View menu)

Click with the mouse on each of the buttons shown here, for a pop up description.
Use this command to display and hide the Toolbar, which includes buttons for some of the most common
commands in Sounds and Noises, such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.
When you move the mouse pointer slowly over the toolbar in Sounds and Noises, short descriptions will 
be dispayed. If the Status Bar. is visible, a one line description is also shown.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



File New

Open a new Sounds and Noises document.(New)



File Open

Open an existing document.    Sounds and Noises displays the Open dialog box, in which you can
locate and open the desired file.(Open)



File Save

Save the active session    with its current name.    If you have not named the document, Sounds 
and Noises displays the Save As dialog box.(Save As)



Edit Enabled

Enable editing of the Sounds and Noises scene. (Enable Editing)



Delete Sound

Delete the most recently clicked sound. (Delete Sound)



Full Screen - Hit ESC to Cancel.

Zooms the scene to full screen. Use ESC to return to normal size. (Full Screen - Hit ESC to 
Cancel!)



Add Sounds

Places Sounds and Noises into edit mode, and brings up the Add Sounds Dialog. (Add Sounds)



Connect Sounds

Aurally connects and repositions adjacent sounds so they will sound out in sequence. (Connect 
Sounds)



Disconnect Sounds

Aurally disconnects all sounds, so they will sound out singly. (Disconnect Sounds)



Word and Letter Options

Brings up a dialog that lets you choose all upper or lower case, or mixed case.    It also controls 
the spacing when you Connect Sounds. See Word and Letter Options



Go

Starts a Train animation, if a balloon was clicked. (Go)



Stop

Stops a running animation. (Stop)



Animation Options

Brings up the Animation Options dialog, which lets you adjust the animation speed to your 
computer, and also controls the mouse pointer size and random animations. See Animation Options .



Quick Start

Takes you straight to the Quick Start    section of Sounds and Noises Help.    Use this whenever 
you forget how to do something in Sounds and Noises!



Status Bar command (View menu)
Use this command to display and hide the Status Bar. which describes the action to be executed by the 
selected menu item or depressed toolbar button.
Until you are familiar with the program, keep this visible.    Helpful hints are displayed in the Status bar 
when you select Menu, or Toolbar items.
A check mark appears next to the menu item when the Status Bar is displayed.
See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Sounds and Noises window.    To display or hide the 
status bar, use the Status Bar command in the View menu.
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you
depress them, or pause with the mouse over them.



Full Screen - Hit ESC to Cancel command (View menu)
Use this menu item, or the corresponding tool bar button, to expand the view window so that    the scene 
fills the screen.    The Sounds and Noises title bar, window menus and tool bar will no longer be visible.    
This prevents your child from clicking madly on things other than the scene. This assumes you are 
running Standard VGA    (640 x 480 resolution), which is recommended.

In Full Screen mode hit ESC to revert back to the normal windowed appearance, or click on the     
button displayed at the bottom right of the scene.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Sounds and Noises and various types of reference information. Click 
here for Sounds and Noises Contents 
Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)
Use this command for instructions about using Help. In particular, try clicking    on the toolbar button that 
has an arrow and a question mark, which provides Context Sensitive Help
The cursor wil change into an arrow and question mark, which you can then click on another menu or 
toolbar item, to find help for that specific item.



Playing Demo (Help menu)

The Playing Demo is a general demonstration of Sounds and Noises, playing sounds and phrases, and 
changing documents.    To run the demonstration, close this Help window, and click on the Help menu of 
Sounds and Noises.    Select Playing Demo, and sit back and relax.    The mouse pointer will be moved 
for you.

Once you are comfortable just playing the different sound combinations in Sounds and Noises 
documents, try the Editing Demo    to learn about how to make up your own unique phrases.



Editing Demo    (Help menu)

The Editing Demo is a demonstration of making a new combination of sounds, using the built in sound 
dictionary, and then saving the sounds as a new Sounds and Noises document.    Be sure you 
understand the basics of Sounds and Noises by running the Playing Demo    first.    To run the 
demonstration, close this Help window, and click on the Help menu of Sounds and Noises.    Select 
Playing Demo, and sit back and relax.    The mouse pointer will be moved for you.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of Sounds and 
Noises.    See About Sounds and Noises .



Context Help command 
Use the Context Help command to obtain help on some portion of Sounds and Noises.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the Sounds and Noises window, such as another Toolbar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
document.
To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.
The Sounds and Noises title bar    contains the following elements:

Sounds and Noises System-menu button in the top left corner.
"Sounds and Noises" followed by the Name of the document.
Minimize button
Maximize button in the top right corner, or
Restore button, to bring the Window back to its normal size



Scroll bars
These are only displayed if the Sounds and Noises main window is substantially smaller than the 
background scene.    When present they will be displayed at the right and bottom edges of the scene 
window.    The scroll boxes inside the scroll bars indicate your vertical and horizontal location in the 
scene.    You can use the mouse to scroll to other parts of the view.

To change the size of the scene, use the mouse to resize the window, or select Size from the System 
Menu.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow 
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (System menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (System menu)

Use this command to reduce the Sounds and Noises window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.    If you are using Super VGA 
or higher resoulution, the window will expand only as large as the background scene.
In VGA screen mode, the maximized size is the same as the available screen size.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Switch to command (System menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



No Help Available

No help is available for this area of the window.



Show Welcome at Start (Help menu)

When you first install Sounds and Noises, the Welcome introduction is automatically displayed to get the
first time user up and running as quickly as possible.    After using Sounds and Noises a couple of times, 
you will probably want to go straight to the application, bypassing the introduction.    Until you decide to 
turn off the welcome, each time you close Sounds and Noises, you will be prompted with a message box
stating "Would you like the Welcome to be shown the next time you use Sounds And Noises? "
If you are comfortable using general menu help (F1) or context specific help (Shift F1), we recommend 
that you answer No to the question    This disables the initial display of the Welcome Introduction at the 
beginning, and will supress the prompt when exiting.
Should you ever want to reenable the Welcome at program start, select this menu item.



No Help Available

No help is available for this message box. Sorry. 



Welcome to Sounds and Noises !
This program is designed so that you can have fun showing your child the sounds of words and letters, 
even if he or she is wriggling on your lap and there is only one hand free to use a mouse.    Click on the 
green, underlined words to explore a topic.    If you see an image move the mouse over it, while watching 
the cursor.    When the cursor changes into a hand, click, and explore what it is pointing to.    To get an 
idea of how simple this can be click on..

Quick Start To learn about Sounds and Noises using a series of pictorial help topics
Demonstrations To see how to play sounds, start animations, and make unique phrases
How to ... To learn how to do something in particular in Sounds and Noises

Sounds and Noises Menu Help Index
File menu Sounds menu
Edit menu Animation menu
View menu Help menu

Demonstrations

There are two demonstrations available from the    Help menu of Sounds and Noises.
Playing Demo
The Playing Demo is a general demonstration of Sounds and Noises.    If this is the first time you have 
started Sounds and Noises, we strongly recommend that you watch the demonstration.    You will be 
shown how to operate the traffic light, to preview ready made phrases, how to select a particular set of 
phrases for play, and to sound out the sounds with animation.
Editing Demo
The Editing Demo is a demonstration to help you make your own unique phrases for your child to 
practice.    You will be shown how to use the built in sound dictionary of sounds, to make your phrases, 
and how to save them as a new Sounds and Noises document.    Be sure you understand the basics of 
Sounds and Noises by running the Playing Demo first.    
To run a demonstration, close the Help window, and click on the Help menu of Sounds and Noises.    
Select either Playing Demo, or Editing Demo and sit back and relax.    The mouse pointer will be moved 
for you.

Go to Quick Start To see another Quick Start help section. 
Opening a Sounds and Noises document To open a specific group of phrases

How To Do Something in Sounds and Noises

Use Context Sensitive Help Figure out anything in Sounds and Noises!
Teach reading with Sounds and Noises! Ideas on how to teach your child.
Quick Start A brief tutorial.
Open a Sounds and Noises document To play a permanently saved session.



Play Sounds and Noises To sound out and start animations.
Edit the Sounds How to move sounds around, or delete them.
Make a Document Make your own tailored lesson.
Save a Document If you want to save a lesson permanently.
Display all Big or Small letters To teach both upper and lower case letters.
Use the Toolbar A quick way to do things.
Use the Add Sounds Dialog To make new words and phrases.
Show only the main scene Prevents your child clicking forbidden things!
Change Animation Speeds If you have a slow computer!
Add your own custom sounds You could record your family's names etc.
Add the PC Speaker Sound Driver If you do not have a sound card.
Register Sounds and Noises! If you like this program and want more..



Quick Start Move the mouse pointer over this page.    Click when it turns into a hand.

Welcome!

Demonstrations

Open documents

Play Sounds

Edit    Sounds

Make documents

Save documents

General Features

Teaching Ideas

Upgrades!

Balloons    (Quick Start)
Red Balloons and Striped Balloons are used to lead sounds across the sky. All the major animations in 
Sounds and Noises are initiated after double clicking on a balloon, or clicking once, and then selecting 
Go from the Animation menu    .
When creating your own phrases (Add or Move Sounds), always use a balloon as the left most sound. 
(Its sound is "Read").
Balloons have the additional property that if you click on them with the right mouse button, then a face 
will appear, and the eyes will follow the mouse cursor. Click again, elsewhere in the scene, and the 
balloon will move to where you just clicked, taking its connected sounds (Connect Sounds).



Sound Sequences    (Quick Start)
In this example you can see some of the number sounds you can select in Sounds and Noises, using 
Add or Move Sounds    . Once placed in the scene, they were aurally connected to the lead balloon and 
each other using the Sounds menu item Connect Sounds .



Start a Train Animation    (Quick Start)
After opening an existing Sounds and Noises document, or adding your own sounds (Add or Move 
Sounds) the train animation can be started by double clicking on the lead balloon, or clicking once to 
sound out the whole sequence, followed by selecting Go from the Animation menu .
Once started, the mouse cursor will change to an arrow and an hour glass, and a helicopter will fly the 
sounds off screen, having been dropped by the balloon    The sounds will reappear as they are pulled on 
train cars to the billboard.    At the billboard, the train will stop, and the sounds will float to the billboard 
and sound out. Then the train will move away, and the sounds are floated back to the starting point by 
their original lead balloon.
 If you want to stop the animation, select Stop from the Animation menu .



Helicopter Animation in Action    (Quick Start)
Here the helicopter is carrying the sounds abandoned by their lead balloon, after the Train Animation 
was started.



Sounds are carried to the Billboard    (Quick Start)
Here the sounds are being transported to the billboard, where the train pauses.    The sounds were first 
carried offscreen by the helicopter after the Train Animation commenced.    The sounds are placed on 
the billboard, where they will be sounded out.



The Billboard    (Quick Start)
The billboard is where the sounds are sounded out.    During the whole animation the string of sounds is 
black, until a particular sound is sounding, when it is red.    Here, "Cat" is sounding at the instant 
depicted.    The whole animation was started by double clicking on the lead balloon, originally floating in 
the sky with its sounds in trail (Train Animation).



The Train    (Quick Start)
The Train Animation is used to lead the sounds to the billboard, deposit them, and then move offscreen.  
It is part of the main animation, begun by double clicking on a balloon.



Traffic Light    (Quick Start)

The traffic light uses the billboard to preview and load documents that contain your saved sound 
combinations.    Normally, the Amber Light will flash, until it is clicked, when one of many precreated 
documents will have its sounds displayed on the billboard.    The text is displayed for a short period.    
Clicking once more on the amber light will show the contents of the next document, in sequence.
To actually load and use the sounds previewed, click on the Green Light.    The billboard will be cleared 
and balloons will be created, towing the text shown.
The Red Light simply clears the billboard of preview text.



Red Traffic Light    (Quick Start)

If the sounds of a Sounds and Noises document are being previewed in small text on the billboard, then 
clicking the red light will clear the billboard.    See Traffic Light    . 



Amber Traffic Light    (Quick Start)

The amber light will flash, until it is clicked, when the next document will have its sounds displayed on 
the billboard.    The text is displayed for a short period.    Clicking once more on the amber light will show 
the contents of the next document, in sequence.    See Traffic Light    . 



Green Traffic Light    (Quick Start)

Click the green light to actually load and use the sounds that were previewed on the billboard by using 
the amber light.    The billboard will then be cleared and balloons will be created, towing the previewed 
text shown.    See Traffic Light    . 



The Kite and other Random Animations    (Quick Start)
The kite serves no purpose in Sounds and Noises.    It definitely entertains small children, and possibly 
will annoy some adults, if it gets in the way!    If the mouse is moved, the kite will try and follow it, 
stationkeeping above and to the right of the pointer.    Once the mouse has been left stationary for a 
short period, the kite will begin moving around the screen randomly.
If an appropriate Random Animation Interval has been set (Animation Options) then periodically 
balloons, or the helicopter, or the train will appear for short periods of time.    These animations can be 
halted using Stop from the Animation menu .



Welcome to Sounds and Noises !

This program is designed so that you can have fun showing your child the sounds of words and letters, 
even if he or she is wriggling on your lap and there is only one hand free to use a mouse.
Sounds and Noises is an animated    "Western" scene in which    parents can teach their children the 
alphabet, some numbers, and    selected words or phrases being sounded out.    A word floating in the 
sky, towed by a balloon, represents a sound that the parent or child can click on to sound it out.    If more
than one letter, or word is added to the right of the first, the sounds can be invisibly connected so that 
clicking on any one sound will cause those to the right to be sounded in sequence. 
Animations add interest for your child to play with the phrases, words, or letters that you decide you 
want to show them.    Our 2 year old learned to recognize specific words very quickly.
Before you use Sounds and Noises, we strongly recommend that you watch the Demonstrations .    
Then browse Quick Start by clicking on each of the topics, which are highlighted and underlined.    The 
Quick Start graphic has "hot spots" which will turn the mouse cursor into a hand, if the cursor is over an 
item of interest.    Click, and an explanation will pop up.
If you have jumped to another page, click on Back at the top of this Window, until you are back at the 
section you want to resume reading. Or click on Contents to go to the beginning.

Demonstrations To see an overview of Sounds and Noises
Go Back to Quick Start To see another Quick Start help section. 

Opening a Sounds and Noises Document
The quickest way to start sounding out sounds is to open an already saved Sounds and Noises 
document, using the Traffic Light .    However, if you know there is a specific document that contains 
phrases that you want to use, you can open the document directly by following the steps below, refering 
to the graphic:

1) Click on the File Menu, and select Open, or click on its toolbar button. Click the file name 
"soundsan.phm", and click OK. 
2) Click on the Maximize button to view as much of the scene as possible.
3) Click the help toolbar button to come back to Quick Start help.

Quick Start To see another Quick Start section. 
Play Sounds and Noises To activate    animations and sounds.



Play Sounds and Noises
Once you have a document loaded, or you have added some sounds, the sounds can then 
be sounded out, as explained in the Demonstrations. Try each of the steps below: 
1) Click on a sound.    It will sound out, followed by sounds to its right, in sequence.
2) Click on one of the balloons.    The balloon should say "Read..", followed by the rest of the
sounds behind it.
3) Double click the same balloon, or click    .      This will start the main train animation.
4) Click on a balloon with the right mouse button. A face will appear, and the eyes will follow 
the mouse pointer. Position the pointer at a new point in the sky. Click once more.    The 
balloon will move its sounds to the new position.

Quick Start To see another Quick Start section. 
Editing the Sounds To rearrange sounds .

Editing the Sounds Move the mouse pointer over this page.    Click on each of the the 
numbers, in sequence,    whenever it turns into a hand.

If you have not already
done so, try the Editing
Demo

Quick Start

Making a document

Enable Editing - Step 1    (Editing the Sounds)

Click on  or Enable Editing in the Edit menu .    This disables the kite, and random background 
animations from moving the sounds you want to edit.    If you clicked on Enable Editing once more it 
would disable editing. We need editing to be enabled. 

Quick Start To see another Quick Start section. 
Moving Connected Sounds - Step 2 Continue    with this section.

Moving connected Sounds - Step 2    (Editing the Sounds)

Click the left mouse button and hold down on the striped balloon.    Its connected sounds will turn black, 



to show that they have been selected for the move, and the mouse pointer will turn into a cross.    Still 
holding the left button down, move the mouse and drag the string of connected sounds to a new location

Quick Start To see another Quick Start section. 
Dropping Sounds - Step 3 Continue    with this section.

Dropping Sounds - Step 3    (Editing the Sounds)

When you have dragged the string of connected sounds to the new position, lift up the left mouse 
button, and the pointer will change back to an arrow.    The sounds will sound out in sequence, just as if 
you had clicked when not in edit mode.

Quick Start To see another Quick Start section. 
Moving specific sounds - Step 4 Continue    with this section.

Moving specific sounds - Step 4    (Editing the Sounds)

The sounds are connected up in a left to right sequence.    To move only the last two sounds in a 
sequence, click on the "Cat" sound, and hold down the left mouse button.    The "Cat" sound, and the 
sound "Sat" to its right in the original sequence will turn black.    Drag the mouse crosshair to a new 
position.

Quick Start To see another Quick Start section. 
Drop the connected sounds - Step 5 Continue    with this section.

Drop the connected sounds - Step 5    (Editing the Sounds)

While holding down the mouse button and dragging the crosshair to a new position, the selected sound 
"Cat" and its right connected sound "Sat" are moved.    Lift up the mouse button and the two sounds will 
sound out.    Click on the red balloon, and lift up the mouse button.    The sounds are still aurally 
connected, and "The Cat Sat" is sounded in sequence, even though the sounds are no longer next to 
each other.

Quick Start To see another Quick Start section. 
Deleting a Sound - Step 6 Continue    with this section.

Deleting a Sound - Step 6    (Editing the Sounds)

You can delete the most recent sound you clicked on by clicking on  or Delete Sound in the Edit 
menu.    The sound is removed from the document.    Now choose Undo Last from the Edit menu.    The 
deleted sound is reinstated.

Quick Start To see another Quick Start section. 
Disconnect Sounds - Step 7 Continue    with this section.

Disconnect Sounds - Step 7    (Editing the Sounds)

Click on  or Disconnect Sounds in the Sounds menu.    Click on the red balloon.    Click on "The".    
The sounds are only played for the object you clicked on.    All aural links have been broken.

Quick Start To see another Quick Start section. 



Connect Sounds - Step 8 Continue with this section.

Connect Sounds - Step 8    (Editing the Sounds)

Remember that in step 5 you separated "Cat Sat" from the red balloon and "The".    Click on  or 
Connect Sounds in the Sounds menu.    Click on the striped balloon.    "Sounds and Noises" will sound 
out in sequence.    Click on the red balloon.    Only the balloon and "The" will sound out in sequence.    
When Connect Sounds is clicked, Sounds and Noises    only connects adjacent neighbors.      Click on 
"Cat".    It will sound out, followed by "Sat" because they were next to each other when Connect Sounds 
was clicked.

Click and hold down on "Cat", and drag it up and just to the right of "The".    Click on  once more.    
The red balloon should once more have "The Cat Sat" nicely positioned to its right.    Click on the red 
balloon to ensure the sequence is correct.

Click on  or Enable Editing in the Edit menu, to reestablish normal animation.    The kite will start 
moving again. 

Quick Start To see another Quick Start section. 

Making a Document Move the mouse pointer over this page.    Click on each of the the 
numbers, in sequence,    whenever it turns into a hand.

If you have 
not already 
done so, try
the Editing 
Demo

Quick Start

Saving a 
Document

Open a New Document - Step 1 (Making a Document)

When Sounds and Noises first starts, a new document is automatically loaded.    If you have already 

loaded an existing document (e.g. soundsan.phm), Click on  or New in the File menu.    If you have 
made any changes to the previous document, you will be asked if you want to save them. 

Quick Start To see another Quick Start section. 



Adding Sounds - Step 2 Continue with this section.

Adding Sounds - Step 2 (Making a Document)

Click on  or Add Sounds in the Sounds menu.    This brings up the Add Sounds dialog.    Editing is 
enabled, and the kite and random animations are disabled.

Quick Start To see another Quick Start section. 
Adding Sounds - Step 3 Continue with this section.

Adding Sounds - Step 3 (Making a Document)

Use the Add Sounds dialog to add a red balloon to the document, at the location where the Next Sound 
Here sign is currently placed.    Click on the Red balloon icon, and it will be created.
Click on the scrollbar to find "Hop", or type in the first few letters in the search box, so that RedBalloon is
highlighted in the list.    An example of how the sound is going to look is shown.    Click on it and you can 
hear its sound.    Click on Use.    It will be placed into the document, and the Next Sound Here sign will 
move to the immediate right.    Select another sound, for example "On", and double click on it in the list.   
This has the same effect as Use, and places it to the immediate right of the previous sound.    Select 
another sound, for example "Pop", in the list, and add it to the document.

Quick Start To see another Quick Start section. 
Add another Sequence - Step 4 Continue with this section.

Add Another Sequence - Step 4 (Making a Document)

To start another sequence, click on the Next Sound Here sign, and drag it to a new position.    If the Add 
Sounds dialog is obscuring a piece of scenery that you need to use, click on the title bar of the dialog, 
and drag it to a more convenient position.
Select either a red balloon or a striped balloon to start the new sequence at the position of the Next 
Sound Here sign.    Click on Use.    Follow the same procedure as in Step 3 to add more sounds to the 
sequence.    Each sound will be placed successively to the right of the previous one.

Quick Start To see another Quick Start section. 
Connect the Sounds - Step 5 Continue with this section.

Connect the Sounds - Step 5 (Making a Document)

You will now connect the sounds in each of the two sequences, so that when either balloon is clicked, 
the adjacent sounds will sound out.

Click on  or Connect Sounds in the Sounds menu.    The sounds to the right of the balloons will be 
rearranged so their bases are all aligned.    Click on each balloon to confirm they are connected aurally.

Quick Start To see another Quick Start section. 
Exit Choose A Sound - Step 6 Continue with this section.

Exit Add Sounds -Step 6 (Making a Document)

After connecting up your sounds in Step 5, you can rearrange them by dragging them with the mouse.    
(See Editing the Sounds).    Note that when Add Sounds was first called up by clicking Add Sounds in the
Sounds menu, editing was enabled.



When you are satisfied with your arrangement, click on Close, in the Add Sounds dialog.    The dialog will
be removed, and editing is once more disabled.    Kite and random animations will resume.    You can 
start animations with the sounds you added by clicking on them, as described in Play Sounds and 
Noises!
Should you need to rearrange the sounds, follow the procedures described in Editing the Sounds.

Quick Start To see another section. 

Saving a Document             

If you have created a new Sounds and Noises document you can save it by clicking on . or selecting
Save ., or Save As in the File menu.    If the document has not been saved previously, a dialog box will 
pop up titled File Save As and a suggested name based on the sounds in your document will be 
highlighted in the File Name edit box.    You can click OK to accept this name, or type in a new name, no 
longer than 8 characters.    Sounds and Noises uses a *.phm extension by default, and this will be 
tacked on to your name.

If the document has already been created and saved to disk,and then edited, it can be saved with its 

current name simply by clicking on  or Save  in the File menu.    If you wish to rename it, then use 
Save As in the File menu.

General Features Learn about Sounds and Noises options
Quick Start To see another section. 

General Features
Using the Sounds and Noises Toolbar buttons or the menus, you can:

Control whether upper or lower case is used when displaying the letters of a sound. 
Adjust the separation distance between two adjacent sounds, that are considered close 
enough to be connected aurally.

 Change the animation speed.
Turn on or off sound in general.
Adjust whether and how often random animations will take place, when there is no activity.

Turn the mouse pointer into question mark, and click on anything in Sounds and Noises you 
whant you want to know about.

Click on the buttons above, to learn more about these controls.

Teaching Ideas How to teach reading with Sounds and Noises
Quick Start To see another section. 

Teaching Ideas

These are some ideas we have had making up phrases and sentences for our young children.
For children less than a year old, build documents with just a few letters of the alphabet, strung together 
in separate strings, towed by balloons.    For example "ABCD" and "EFGH",    or just separately.    When 
you start an animation with one of the balloons, it is fun to talk about the letter being "taken away".



There are also some individual numbers in the list, which can be used for counting practice, either 
increasing or decreasing order, or some random mix, for older children.
After 2 years of age, we found that letter recognition is perfect, in upper case, and started to switch to 
lower case.    A few    words like Daddy and Mommy, and the childs name were introduced, and were 
quickly recognized.
Toward 3 years of age, the child can use the mouse better than you can, and you can show them how to
sound out the sounds, and start the animations.    We suggest using the    Full Screen    command, in 
normal VGA 640 x 480 resolution, if you find your child is getting more interested in the toolbar than the 
letters!
As for how to teach children over 3 how to read, well there are far more qualified teachers and books out
there explaining their different techniques.    We have been simply stringing the simplest words together, 
often with our names, or the childs, mixed in.    You can add Custom Sounds if you have a registered 
copy of Sounds and Noises!    As the animation takes the sentences off screen, we tell a story about the 
train bringing our words back, and when the animation finishes, the story is about the train leaving to get
more letters.
Improvisation and time spent with your child is the key to success.    Time spent with a wriggling child on 
your lap is the most important part of their learning to read.    This program needs an adult to keep 
changing the words and making the interaction interesting.    It is not a very good baby sitter, where you 
can leave the child alone, even when your child can use a mouse.
We hope you have fun with Sounds and Noises! 

Register for Upgrades! How to get extended versions of Sounds and 
Noises!

Quick Start To see another section. 

Sounds Menu commands
The Sounds menu offers the following commands:

Add Sounds Lets you select different 
sounds from a list

Connect Sounds Neatly repositions sounds, to 
be sounded in sequence

Disconnect Sounds Removes all links between 
sounds, to sound separately

Word and Letter Options Lets you select all upper or 
lower case, or mixed

Custom Dictionary Use this to add your own *.wav
files to Sounds and Noises!



Add Sounds command (Sounds menu)

This command and its corresponding tool bar button brings up the Add Sounds dialog, and places a Next 
Sound Here sign in the main scene. To learn about specific items move the mouse over the dialog below, 
and click when the cursor turns into a hand, to learn about the object the hand is pointing at.

If you double click on one of the words in the main dialog list, or click once on the sound you want, and 
once on the Use button, the desired sound will appear in the main scene, exactly where the Next Sound 
Here sign used to be.    The Next Sound Here sign will move to the right of the sound you just chose, 
representing where the next sound that you select, will go.    In this way, you can create a string of 
sounds, making up a sentence or phrase, or just A B C D...etc.
While this dialog is active, editing in the main scene is enabled. See Enable Editing

 In particular if you click on any sound in the main scene, including balloons, the mouse cursor will 
change into a crosshair, and if you keep the left mouse button held down, and move the mouse, you will 
be able to drag the sound you clicked on anywhere that you want it to be, within the main scene.    The 
same is true for the Next Sound Here sign, so that if you want to start a new Balloon phrase, just drag 
the Next Sound Here sign to a piece of clear sky, in the main scene, and then select a balloon in the 
dialog list, and click on Use.    The lead balloon will appear where you left the Next Sound Here sign, and
the Next Sound Here sign will now be in position to its right, where the next sound that you select will be 
placed.. 
For more information see Making a Document in the Quick Start tutorial. 



Title Bar (Add Sounds)
The Add Sounds dialog is placed by default at the bottom right of your screen.    If you need to move it, 
to see what is in the main scene behind it, then click on the title bar, and hold the left mouse button 
down, and move the mouse to drag it to a new, more convenient position.



List of Sounds (Add Sounds)
This is the list of all possible sounds available for use with Sounds and Noises.    Use the scroll bars at 
the bottom of the list to see all sounds from A to Z. 
Click on the sound that you want, and it will be highlighted, and an example of how it will be displayed 
will appear in the example window.    Click on the example and it will sound out if you have sound 
enabled in Animation Options. 
If you double-click on the highlighted sound in the list, or on Use, then that sound will be placed in the 
main scene, at the current position of the Next Sound Here box. 



Search for a Sound (Add Sounds)
If you cannot see the sound you want in the list box, even if you use the scroll bars below it, then try 
typing in the first few letters of the sound.    The list box will scroll alphabetically to the closest match that 
it can find to what you typed in this box.    Whatever is displayed in the example window, and is 
highlighted in the list, will be used in the main scene, if you click on Use.



Close (Add Sounds)
This will close the dialog, leaving all the sounds that you place in the main scene, available for use.    
Note: editing will be disabled, by default, so that your child cannot casually rearrange your sounds.    
Normal play will resume by clicking on a sound once to sound out sounds, or twice on a balloon to start 
the train animation .
To reenable editing so that you can drag, or delete the sounds, see Enable Editing



Use (Add Sounds)
When you click this button the sound highlighted in the list and also displayed in the example window, 
will be placed into the main scene, at the current position of the Next Sound Here box.



Help (Add Sounds)

This button brings up the Help you are browsing now.



Example of Sound (Add Sounds)
If you click this window, you will hear the sound, if you have sound enabled in Animation Options.    The 
example is the true size and color that will be used when you click on Use, to place it into the main 
scene.



Add a Balloon    (Add Sounds)

Click on either the red or stripe balloon icon, to quickly add it to the scene. (It will take the place of the 
"Next Sound Here" sign).    Balloons should always be used to start a new phrase or sequence of sounds
that you want to be connected, or that are to be used by the train animation.



Undo    (Add Sounds)

This removes the last sound you added to the scene, if you have not closed Add Sounds in the interim.



Connect Sounds command (Sounds menu)
This menu item, and its corresponding tool bar button, can be used either in edit mode or normal play, to 
neatly reposition neighboring sounds and balloons, if they are within a small distance from one another.    
Once a sound has been repositioned, and made a neighbor of one to its left, then it becomes aurally 
linked with its neighbors.
Check the link by clicking on the left most sound of a string of sounds, they should sound out in 
sequence, if they were already close enough when this command was selected.    If one or more sounds 
are still disconnected, enter edit mode by selecting Enable Editing. Click on the left most sound of the 
disconnected string, and drag it so that it is more closely positioned as a sequence.    All of its connected 
neighbors will move with it, to facilitate the line-up of many sounds.    Select Connect Sounds once more, 
and click once more on the left most sound.    This time they should sound in the proper sequence.

Once sounds have been aurally connected, they can be physically separated by dragging, in edit mode, 
even to opposite sides of the scene, and still sound out in sequence, because the links are unaffected by
the relative positions of the sounds.    To break the links, select Disconnect Sounds



Disconnect Sounds command (Sounds menu)
This command and its associated tool bar button will disconnect the aural links between sounds, that 
were set up when they were joined up as neighbors using Connect SoundsNo repositioning of the sounds
will take place.    Only the sequencing of the sounds is affected.    After selecting this command, clicking on
any particular sound will cause it to sound out, but not any others.    If two sounds are accidentally joined 
up, because of their proximity to each other when Connect Sounds was selected, then this command will 
reverse that action.    Enter Enable Editing and move the sound by dragging with the mouse, so that it is 
no longer near the sound with which it became aurally linked.    Then once more select Connect Sounds 
to reestablish the desired aural connections.



Word and Letter Options command (Sounds menu)
This command and its associated tool bar button selects the Word and Letter Options dialog shown 
below. To learn about specific items move the mouse over the illustration, and click when the cursor turns 
into a hand, to learn about the function the hand is pointing to.



All Capital Letters (Word and Letter Options)
Click this radio button to make Sounds and Noises display only upper case letters. Disconnect Sounds 
followed by Connect Sounds will be called automatically to rearrange the scene to accommodate the 
new letter sizes.



First Letter of Each Word (Word and Letter Options)
Click this radio button to make Sounds and Noises display the first letter of each sound as Upper case, 
with the remaining letters in that sound lower case.    Disconnect Sounds followed by Connect Sounds 
will be called automatically to rearrange the scene to accommodate the new letter sizes.



No Capital Letters (Word and Letter Options)
Click this radio button to make Sounds and Noises display only lower case letters.    Disconnect Sounds 
followed by Connect Sounds will be called automatically to rearrange the scene to accommodate the 
new letter sizes.



Reposition Close Together (Words and Letter Options)
When this radio button is set and Connect Sounds    is selected, only those sounds that have been laid 
out already close together (almost touching) will be connected aurally, and repositioned.    When they are
within the rage of each other to be repositioned, then they will be positioned almost touching.
 Disconnect Sounds followed by Connect Sounds will be called automatically to rearrange the scene to 
accommodate the new letter sizes.



Put a Space In-between (Words and Letter Options)
When this radio button is set and Connect Sounds    is selected, those sounds that have been laid out 
within a space of each other will be connected aurally, and repositioned with a space in-between.    
Disconnect Sounds followed by Connect Sounds will be called automatically to rearrange the scene to 
accommodate the new letter sizes.



OK (Word and Letter Options)
Click or hit Enter to close this dialog, and put into effect the selections you have made.Disconnect 
Sounds followed by Connect Sounds will be called automatically to rearrange the scene to 
accommodate the new letter sizes.



Cancel (Word and Letter Options)
This will close the dialog leaving the current selections in place.



Help (Word and Letter Options)
Clicking this button will bring up this help topic.



Animation Menu commands
The Animation menu offers the following commands:

Go Starts a Train animation with sounds behind 
a balloon, if it was the last object clicked.

Stop Stops any animation or sounding in progress,
indicated by an hour glass with an arrow.

Animation Options Changes animation speed, mouse cursor 
and and random animation frequency.



Animation Options command (Animation menu)
This command and its associated tool bar button selects the Animation Options dialog shown below. To 
learn about specific items move the mouse over the illustration, and click when the cursor turns into a 
hand, to learn about the function the hand is pointing to.



Stop command (Animation menu)
This command and its associated tool bar button is enabled whenever animation is in progress.    This is 
when a Helicopter or Train is moving, or a balloon and its connected sounds is being repositioned, or 
when sounds are sounding.    As well as the Stop tool bar button appearing as bright red (enabled), the 
mouse pointer will have a small hour glass attached to it.
Clicking on the tool bar button, or selecting the menu item, or opening a new Sounds and Noises 
document, will cause the animation to be accelerated to completion. When an animation is running, 
normal clicking to sound out sounds, and editing, are disabled.
To start an animation see Go .



Go command (Animation menu)
This command and its associated tool bar button can be used (highlighted) whenever Sounds and Noises
is not in edit mode (Enable Editing ) and the most recently clicked sound is a balloon.    When the Go 
button is clicked, or the menu item selected, or a balloon is double clicked, the full Helicopter and Train 
animation will begin, sounding out the aurally connected sounds (Connect Sounds) that have been 
connected to the balloon.    See also Play Sounds .
To stop an animation quickly, see Stop .



Set Animation Speed (Animation Options)
Push these buttons to select faster or slower animations.    Depending on your computers speed, you 
may need to adjust this setting.    Both the Train and Helicopter animations are affected, as are the 
random animations.    The slowest animation speed will produce the smoothest animation.



Big Mouse Pointer (Animation Sounds)
Check this check box to enable a large mouse pointer when the cursor is over Sound And Noises.    This 
is recommended for children just learning to use the mouse.



Sound (Animation Options)
Check this box to enable sound.    If you are at the office, or the sounding out of the sounds is slowing 
down your editing, then turn this off!



Installing a Sound Driver

In order to play sound, Sounds and Noises assumes the standard Windows multimedia extensions have
been installed with Windows 3.0 with Multimedia Extensions, or Windows 3.1 or later, which has them 
built in.    
If you know you have a sound card installed (which normally comes with external speakers), then check 
for the correct sound driver (for wave files) in the Drivers section of Control Panel.    You will need to 
reference the sound card installation section of the manual that describes your sound card.
However, if you do not have a sound card installed in your computer (in this case you have no 
speakers), you can still use Sounds and Noises to sound out words and letters, by installing the PC 
Speaker Driver, included in the \SPEAKER directory on the Sounds and Noises setup disk 1.    Once this
is installed, you can control the length of time that a sound can be played using the PC Speaker Setup 
button, in the Drivers section of Control Panel.    For maximum sound quality, select "Disable Interupts".   
Note that while a sound is playing, this driver prevents all other Windows activity.
If you are unable to successfully install a sound driver, you can still use Sounds and Noises, but without 
sound, by unchecking Sound in Animation Options .



OK (Animation Options)
This closes the dialog, and puts into effect the settings displayed. Click on Cancel if you want to resume 
Sounds and Noises with the previous settings in effect.



Cancel (Animation Options)
This closes the dialog, and resumes Sounds and Noises, using the previous settings.



Help (Animation Options)
This brings up the Help that you are viewing now.



Random Animation Interval (Animation Options)
This lets you select the interval betwee the random animations that will occur if no user activity is 
detected.    If you do not want any random animations to occur, either disable editing (Enable Editing) or 
select None in this dialog.



Register Sounds and Noises!

If you find Sounds and Noises is a useful program for your family, and you would like to have the latest 
version that lets you add your own words and sounds, and has more built in words, then please register 
with us.    If you specify up to three additional names (of your children, for example) we will add these 
sounds to the dictionary on your floppy.    Additional names can be added by us, for a nominal charge of 
$1 per name.        You can register with us using one of two methods.

Either
Send a check for $10 plus $1 per each additional name beyond 3 , made out to Sounds and Noises! to 
the address below, with your shipping address, and we will send you our latest on a 3.5" floppy.    Click 
on Order Form for a ready made order form that you can print from the Help File menu.

Sounds and Noises!
P.O. Box 806                            

    Seabrook TX    77586
    USA

Or
You may register using Compuserve by typing GO SWREG, and entering id. 4488 in the Author ID box.   
Follow the instructions.    The charge will be debited from your Compuserve account.
Registered users will be sent the latest version of Sounds and Noises!, which has the additional 
capability to utilize Custom Sounds files that the user has recorded using a sound card, as well as    
Many more Built In Sounds, and sounds for the additional names you require.    In addition, we will 
provide support via email at 71155.3133@compuserve.com, and offer inexpensive upgrades to Sounds 
and Noises, including new scenes and themes such as a Space setting, and an Underwater setting, as 
they become available. 

Quick Start To see another section. 

List of Built In Sounds
The following list of sounds are built into the Registered version of Sounds and Noises.    If additional 
sounds are required, you can add your own Custom Sounds or specify the additional sounds when you 
Order the registered version of Sounds and Noises.

A
Above
All
Am
And
Ants
Are
At
B
Baby

Green
Grey
H
Hand
Happy
Has
He
Hello
Hop
House

Red
Rug
Run
S
Sad
Sand
Sat
Say
Scrub
She



Bad
Bake
Be
Bee
Berries
Black
Blue
Boat
Book
Boy
Brown
Bug
Bunny
By
Bye
C
Cake
Car
Cat
Cherries
Clown
Cup
D
Dad
Daddy
Day
Dog
Down
E
F
Fish
Five
Float
Fly
For
Four
Frog
From
Funny
G
Girl

I
in
is
It
J
K
L
Lake
Log
Look
Loves
M
Me
Mad
Mat
Mom
Mommy
Moon
Mouse
My
N
Night
No
Noises
Not
Nurse
O
Of
on
One
Or
Orange
Out
P
Pants
Peach
Play
Pop
Pup
Purple
Purse

Sing
Sky
Sleep
Snail
Snake
Sounds
Star
Stay
Stop
Store
Sun
Swing
T
Talk
The
They
Three
Top
Toy
Track
Trail
Train
Treat
Tree
Trick
Two
Tub
U
Under
up
V
W
Was
We
Were
Will
Wish
With
Walk
White
X



Glad
Go
Good
Grandma
Grandpa

Q
R
Rain
Reach
Read

Y
You
Yes
Yellow
Z



Order Sounds and Noises

Print out this form by clicking on the File menu, and then select Print.    Send the completed form with a 
check for the total to:

Sounds and Noises!
P.O. Box 806                            

    Seabrook TX    77586
    USA

Please print the address to which the software should be sent:

Name:
Street:
City:
State:
Country:

Dollars    (U.S.)
Number of copies of 
Sounds and Noises at 
$10 each

                                                      x 
$10

First 3 additional unique 
sounds of personal 
names to be included free
in the dictionary

Name 1:
Name 2:
Name 3: -----------

Additional names to be 
included in the dictionary 
at 1$ per name

Name 4                                    
x$1
Name 5:                                  
x$1
.

Total remitted 



About Sounds and Noises! 
Sounds and Noises Version 1.1
Copyright 1994 by Colin Michael Foale.
All rights reserved.



Custom Dictionary command (Sounds menu)

The Custom Dictionary enables you to add your own custom recorded sounds, to Sounds and Noises!     
Move the mouse over the graphic to learn about the dialog.    To learn about recording your own sounds 
and extending Sounds and Noises, click on Custom Sounds . This command is only available in the 
registered version of the program. 



Enter Letters for the Sound (Custom Dictionary)

Enter the letters or words that you want to be displayed for the sound file you are adding.    Any 
combination of spaces and characters can be used.    For example, you could record "It rains on the 
plain in Spain" as a wave file called "itrains.wav", and type into this box "It rains on the plain".    This text 
is what will be displayed as a choice in the Add Sounds list.



File Name for the Sound (Custom Dictionary)

Enter the file name of the sound you want to add.    It should have a .wav extension, and for 
convenience, should be copied to the Sounds and Noises directory (c:\phonetic by default).    If you want
to include a wave file not in this directory, specify the full path name of the file, so that Sounds and 
Noises can find it. (For example "c:\windows\tada.wav".)    If you cannot remember the file name exactly, 
use the File... button to bring up a File dialog to browse wave files in different directories.



Add/Change (Custom Dictionary)

Once you have entered a new set of letters in the Letters box, and a sound file name in the File Name 
box, you can add the sound to the custom sound list by clicking this button.
If you have selected a previously entered custom sound from the list, and you have only changed the file
name, (not the letters for it), then clicking on Add/Change will update the entry in the list to reflect the 
new file name.



Delete (Custom Dictionary)

If you no longer need a sound in the custom sound list, select it by clicking on the entry in the list.    The 
letters for it will show up in the Letters box, and the file name will be displayed in the File Name box. 
Click on Test, to be sure it is the sound you want to delete. Click on this button to remove the sound from
the list.    Note: The sound file itself will not be deleted from your disk; only the references to it in Sounds 
and Noises.



Close (Custom Dictionary)

Click this button to close the Custom Dictionary dialog.    Any changes or additions you have made to the
list will be permanently recorded.    Click on Cancel if you do not want any changes to be made to the 
existing dictionary.



Cancel (Custom Dictionary)

This closes the dialog without permanently saving your changes to the Custom Dictionary list.    Use this 
only if you know you do not want to make any changes.



Test Sound (Custom Dictionary)

If there is a file name displayed in the File Name box, you can check it for sound by clicking on this 
button.    If a problem is found a message will be displayed.



Help (Custom Dictionary)

This brings up the help you are reading now.



Custom Sounds List (Custom Dictionary)

This list box can be scrolled to show all the custom sounds you have assigned to date.    It will be empty 
the first time you select the Custom Dictionary.    Each sound file and letter combination you add to the 
dictionary will be reflected in this list.    To change the file name or hear the sound of an entry in the list, 
click on it and its letters and file name will be displayed in the boxes.    Click on Test to hear its sound.    
Note that Sounds and Noises will always save the letters as lower case, so they can be distinguished in 
the Add Sounds dialog.    Use the Word and Letter Options dialog to control how Sounds and Noises 
displays the case of the letters in an actual document 



Extend Sounds and Noises with Custom Sounds 
If you have a sound card installed in your computer, and a microphone, you can either use the recording
software and documentation that came with your sound card, or you can use the Sound Recorder 
application in the Accessories group in Program Manager, to record your own unique sounds.    (If you 
had to install the    PC Speaker Driver during Sounds and Noises setup, you will not be able to record 
sounds, without a sound card.)    For example you could record your family names, as wave (*.wav) files.
The files should be edited to be immediate and brief in playing their sounds.
Once recorded as *.wav files, copy them to the Sounds and Noises! directory (the Setup default 
directory was c:\phonetic - you might have instructed Setup to use a different directory.    In that case, 
use copy the *.wav files to the directory you specified).    Use the Custom Dictionary dialog to assign the 
letter text that Sounds and Noises will add to the Add Sounds dialog, and which will be displayed in your
documents when you select those sounds.    Clicking on the assigned letters for your custom sound file, 
will cause Sounds and Noises to play the attached file, rather than look in its internal sound list.
Because Sounds and Noises always scans the custom sounds before its own, you can override what 
Sounds and Noises plays, for a given letter combination.    For example "Train" is one of Sounds and 
Noises internal sounds, displayed in the Add Sounds dialog.    If you wish to substitute your own wave 
file to be used instead of the internal sound, use the Custom Dictionary dialog to assign the letters 
"Train" to your wave file.    When you select Add Sounds you will see the entry "train",    in lower case, 
showing that the sound has been overridden.
A Technical Note:
The map of sound files (*.wav) to letter combinations is a simple text file named phonetic.dic, in the 
Sounds and Noises directory (c:\phonetic by default).    Generally you should never need to edit this file 
directly, but if you do, be aware of the text formatting. The Custom Dictionary dialog provides the 
interface to this file, and it is recommended that it should be used for all updates to it.



Custom Dictionary Not Available
The Custom Dictionary is not available in this version of Sounds and Noises! 

Register    and receive the latest version of Sounds and Noises that lets you add your own words and 
sounds, and includes Many more Built In Sounds.




